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CDM+ Notices

Professional and Personalized Communication (from within CDM+)
CDM+ Notices make it easy for you to upgrade the appearance of letter, card, and email communications with 
your congregation and staff members. A powerful word-processing interface is built directly into Notices 
reports throughout CDM+, so you don’t need to open multiple programs to create nice layouts. Since the 
Notices interface also lets you drag and drop database fields right into your text, there’s no need for data 
or mail merges, either. With CDM+  Notices, personalized, professional communication is suddenly simple.

This class deals with creating and formatting notices. Determining who gets a notice is covered in other 
classes, such as, Advanced Finds and Searches, and program-specific classes, such as Membership Notices 
and Exports.

Where to Find Notices
Notices with word processing and data merge capabilities are found throughout CDM+, generally on the 
Reports menu under Notices (with some exceptions noted below):

Membership Notices – Address or Individual Letters, Cards, and Emails

Attendance Notices – Attendance or Missing Letters, Cards, and Emails

Visitor Notices – Visitor Letters (accessed from the Visitor Letter Assignment window on the Attendance 
program menu)

Contributions Notices – Giving Unit, Contribution, and Pledge Letters, Cards, and Emails; Giving Statement 
(column and line) Emails and Receipts Letters under Statements/Receipts

Memorial Gifts Notices – Gifts Given Letters, Cards, and Emails

Accounting Notices – Accounts Receivable Email Invoices

Event Registration – Registration or Activity Letters, Cards, and Emails 

Check-In/Check-Out Notices – Letters and Cards

Church Notices – Letter, Card, and Email (for CDM+ Regional users)

Church Position Notices – Letter, Card, and Email (for CDM+ Regional users)
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What’s Possible? 
Colors, graphics, special fonts, and more! 
This Address Letter Notice illustrates 
some of the ways CDM+ Notices can 
change an organization’s communications. 

A personalized letter is much more likely 
to be read as the same letter addressed 
to “Dear Parent.”  The addition of text 
formatting and a photo further increases 
its likelihood of being noticed.

Creating Notices
The example below is an Individual Letter Notice from the Membership Reports menu, but the steps apply 
to any notice (letter, card, or email) in CDM+. However, be aware that your control over the final appearance 
of an email is limited. Recipients’ email programs may display your email notice differently than you expect.

Begin by selecting Individual Letter Notices, either from the menu or the Welcome to CDM+ Membership 
window.

Click Notice from the left sidebar. You may 
choose an existing Letter Notice to edit or 
duplicate, or you may create a new Letter 
Notice. In any case, first click the Select/Add 
button next to the name of the last letter 
notice that was used.
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A new window will open in which you’ll see any existing notices. On this window you have the option to 
choose an existing notice, add a new notice, duplicate an existing notice, rename an existing notice, or delete 
an existing notice.

If the letter you want to send already exists 
or if there is an existing letter you can edit, 
highlight its name and click Choose.

To create a new letter notice, click the Add icon at the top right of the window. 

If you want make changes to an existing notice, but not lose the original version, highlight it in the list of 
Notices and click the Duplicate icon at the top of the window.

When you choose to Add or Duplicate a 
notice, you will be prompted to name it. 

Give the letter a name that will help you 
identify it when you wish to use it again. This 
name does not appear on the notice itself.  
Click OK.

The name of the new notice will be added to 
the Notices list and highlighted.

Before leaving the select notice window, you may optionally set access to the new notice you have just named 
and/or assign it to a category.
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Setting Access to Notices
Access to a notice in CDM+ can be restricted by the person who creates it. Administrators can change notice 
ownership and delete notices under File u Administration u Notices.

View Access
With your notice selected in the list, click on the View Access tab. This setting restricts who can see and use 
this notice as you created it.

If you leave the View Access set to Default, all CDM+ users will see this notice 
displayed in the Notices list and can use the notice as you created it.

If you wish this notice to be Private, to only appear in the Notices list for 
you when you are logged in, click the radio button next to Private. No other 
users will even know this notice exists. 

If you click on the radio button next to Selected, you can then choose specific 
users you wish to give View Access to for this notice.

Modify Access
With your notice selected in the list, click  on the Modify Access tab. This setting restricts who can modify a 
notice you created.

If you leave the Modify Access set to Default, all CDM+ users will be able to 
make changes to the notice.

If you don’t want anyone else to be able to make changes to this notice, click 
the radio button next to Private.

If you click on the radio button next to Selected, you can then choose specific 
users you wish to give Modify Access to for this notice.

Info
With a notice highlighted, click on the Info tab to view more information about this notice.
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Notice Categories
 • Optional

 • Apply to all types of Notices (Letter, Card, and Email) in all CDM+ programs

Creating Notice Categories

 • Creating notice categories can be done in two different ways, On-the-Fly and through the Master 
Coding System

On-the-Fly

With the Select Notice window 
open, click Add Notice Category. 

Enter the category name, e.g. 
Children’s Dept., and click OK.

Master Coding System 

u File uMaster Coding System 
uCodes tab

Highlight Notice Category in the list 
of code types. Click the small Add 
button below the list of code, type 
the category name under Description, 
and click Save.

You may also Edit or Delete categories 
here.

 To enter multiple codes, press Tab to move the cursor to the next line between entries. Click Save 
when finished.
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Assigning Notice Categories
• Click on <No Category> to see which notices have not been assigned.

Existing Notices can be assigned to categories at any time. Click on <No Category> in the Categories list to 
see all notices that have not been assigned to a category. To assign a notice, simply click it in the Notices list 
once to highlight and drag it to the appropriate category.

 Save time by selecting 
multiple notices at once 
and dragging them to a 
category. 

New Notices automatically assign a new notice by highlighting desired the category before clicking the 
Add button.

Finding Categorized Notices
Once you have assigned notices to categories, to find a particular type of notice, such as Christian Education, 
click on the category at left and all assigned notices will display in alphabetical order in the list to the right.

You can always click on <All> to see all saved Notices, both assigned and not.

Tracking and Resending Notices
CDM+ provides the ability to track when and to whom notices have been sent. For email notices, under 
the Body section of the Email notice window, CDM+ shows Last Sent: with the date the selected notice was 
last sent. 
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Record windows that relate to people in CDM+ contain a Notices tab. For example, on the Notices tab 
for an individual, address, or giving unit, CDM+ displays the list of notices sent with the notice type, 
description, and date sent. For email notices, CDM+ also shows the name and email address of the 
recipient. 

To bypass saving this information for letter or card notices, check the Do Not Save Sent Information box on 
the Notice window.

Each line of the Notices tab contains buttons to get more information about the notice, resend the notice, 
or delete that notice line for that particular record.

From the Program menu in CDM+, you can access Sent Notice Records for the various record types. For 
example, you can go to Program  u Membership  u Individual Sent Notice Records to search for notices 
that were sent to individuals. Sent Notice Record windows contain two tabs. The Notice tab shows the 
description, type, and last sent date and time for the notices. Letter notices show a thumbnail of the 
notice. 
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The Recipients tab shows the list of recipients. To resend the notice, select recipients from the list who 
need to receive the notice again, and click the Resend Selected button. You can also remove the sent 
notice from recipients by selecting them in the list and clicking Remove Selected.

Formatting/Editing in the Notice Editor
Either double-click the name of your notice on the select notice window 
or highlight it and click the Choose button. The notice report window 
will reopen with your selected notice displaying.

Click the small Change button below the Body field to open the editor 
window. Click inside the window to place your cursor and begin typing.

There are two ways to style the text in the notices editor window: 

1. The Formatting Palette, which opens to the right of the notice 
editor window

2. The Format button (3rd from the top in the series of buttons at the 
top right of the editor window)

Clicking the Format button brings up windows with options to style 
the Font, Paragraph, Document, and more.

The Formatting Palette:
– Opens automatically with the Notice Editor Window and maintains its position to the right edge of 

the notice editor when you move or re-size the editor window.

– Contains sections that will be familiar to all who have used a word processing program: Font, 
Alignment and Spacing, and Document.

– Also has a Database Fields section, which allows the quick insertion of information from CDM+ into a 
letter or other notice. The Database Fields function eliminates the need for data merges or mail merges.

– Styles existing text when text is highlighted or sets defaults for text yet to be entered.

The following topics describe each section of the Formatting Palette. Remember that most of these styling 
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options are also available by clicking the Format button and choosing a menu item. Clicking a menu item 
after clicking the Format button opens a new window with formatting options.

Font

Choose your Fonts and Point Sizes from the drop list. All fonts installed on your computer are available for 
use in CDM+ Letter Notices.

NOTE:  Be aware that “special” fonts used in an Email Notice will be replaced with another font if recipients 
do not have access to that same font on the computers or mobile devices where they are viewing the email. 

Click on the box next to Color to display a color palette. Click the desired color. Then choose to style your 
text with any of these Face options:

 –  Bold
 – Italicize
 – Underline
 – Superscript
 – Subscript
 – Strike-through and/or double strike-through

These settings can also be specified by clicking on the Format button at the side of the notice editor window 
and choosing Font.
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Numbered or Bullet List

Also in the Fonts section of the 
Formatting Palette are buttons 
to change text to a numbered 
or bullet list .  The left and 
right arrows next to the list 
buttons adjust the indention 
of the list. Click on the Format 
button and choose Bullets and 
Numbering… to set the style 
of a list.

Alignment and Spacing

Expand the Alignment and Spacing section of the Formatting Palette and select options there to:

 – align text (left-, center-, right-, or full-justified)

 – set line spacing (single, one-and-a-half, or double)

 – set paragraph spacing and indents

These same Alignment and Spacing settings can be set in the Paragraph Properties window accessed 
through the Format button. Additionally, you may set tabs in the Paragraph Properties window by specifying 
them numerically. Indents and tabs can be set using a ruler in the Document section of the Formatting Palette.
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Document

                 

The Document section of the Formatting Palette is where you:

 – Set margins
 – Choose a standard paper size and orientation or a custom paper size

 – Control how the page is displayed and the magnification of the page

 – Choose whether or not to show rulers (the top ruler is where to set indents and tabs)

Click the Tab icon  to change the type of tab (left-justified, right-justified, centered, decimal).

Database Fields 

This section of the Formatting Palette contains what really sets CDM+ 
Notices apart from using a word processor to send letters to your 
congregation. Here you select information found in CDM+ to insert 
in your letter without the steps of exporting and data merging.

Click on the drop list to see a Category of database fields. Select a 
Category to see a list of available fields to insert in your letter. For 
instance, place your cursor in the letter at the point you want to insert 
the name of each individual’s Sunday School Class in a letter and either 
double-click “Sunday School Class” in the list of fields or highlight it and 
click on the Insert Field Icon 
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The selected field will be added to your letter:

If you click the Preview button at the side of the notice window, you will see an example of the result:

Clicking the Preview button again will return you to the notice entry mode. 

Inserted Database Fields may be formatted just like any other text in a notice. Highlight the field name and 
choose the font, size, color, etc.

Click the Preview button again, to see an example of the result of the formatting:

 To  avoid blank lines in addresses, use the Address Block field from the Address database field list, 
instead of:

 Address Line 1
 Address Line 2
 Address Line 3

City, State and Zip

The above format will result in a blank line in the address if any of the Address Line fields is empty.

NOTE: Some fields, such as Full Individual Name, have options that can be controlled from the Format tab 
on the report window.
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Date and Time

Two of the categories available in 
Database Fields are Date and Time. 
Choose from the formats listed to 
insert the current date or time when the 
notice is printed (or emailed) into the 
document.

NOTE:  If you want a specific date or 
time printed on the notice, do not use 
the Date or Time field, but rather type 
it in the notice.

Inserting Page Breaks, Files, Text Borders, and Hyperlinks
CDM+ Notices have the ability to insert Page Breaks, 
Files (text and graphics), and Text Boxes into the 
body of the notice.

Page Break

Place your cursor where you want to add a page break, click the Insert button on the side of the Notice 
window, and click on Page Break in the pop-up window.

To remove a Page Break, highlight it and press Delete on your keyboard.

Note:  It is possible to insert Page Breaks into card and email notices, but they have no meaning for those reports. 
It is recommended you only use Page Breaks in letter notices.
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File

To insert a file:

1. Place your cursor where you want to add either a graphic (.jpg, .png, or .pcx) or text (.txt or .rtf ) file.

2. Click the Insert button on the side of the Notice window.

3. Click on File in the pop-up window and select the type of file you wish to insert from the drop list.

4. Browse to select the file.

Graphic from Database

Selecting this Insert option allows you to insert a graphic from the CDM+ Graphic Browser. You can import 
as many graphic files in the Graphic Browser as you like so that they are always readily at hand for use in 
CDM+. Examples of graphics you might want to import include:

 – A scan of the pastor’s signature

 – A graphic of your church’s logo 
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The Graphic Browser is also used in name 
badges, checks, and the yearbook directory, so 
images added to the graphic browser here are 
available in all these locations. 

To insert a graphic from your CDM+ database:

1. Place your cursor where you want to add 
the graphic.

2. Click the Insert button on the side of the 
Notice window.

3. Click on Graphic from database . . . in the 
pop-up window. The Graphic Browser 
will open.

4. Choose an existing graphic from the 
Thumbnails on the left side of the 
Graphic Browser 

5. Click OK.

To add a graphic file to the CDM+ Graphic Browser:

1. Click the Add button on the bottom of the Graphic Browser window or the Import button at the top 
right of the Graphic Browser window. 

2. Browse to find the graphic file, select it, and click Open. 

 

 The graphic appears in the Graphic Browser window. 
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3. Type a Description of the graphic.

4. Click OK. The new graphic will appear in your notice wherever you last placed the cursor.

NOTE:  CDM+ will import all graphics at 96 dpi. If your original graphic was at a higher resolution, such as 300 
dpi, you will notice the Size indicated on the Graphic Browser window after importing will be larger than the 
original. Re-sizing the graphic back to the original size once you have placed it in the notice will return it to 
a print-quality resolution of 300 dpi.

If you plan to use a graphic in Email Notices ONLY, you may wish to save it at the size you want at 96 dpi 
resolution to avoid having to re-size it and ensure it will appear in email messages as you desire. However, 
be aware that a 96 dpi graphic, when used full size, will NOT print well.

To remove a graphic from the Graphic Browser, select the thumbnail on the left and click the Delete button 
at the bottom of the window.

Formatting Inserted Graphics

Once you have inserted a graphic in the notice, either from a file or the database, you may format that graphic.

Click the graphic once to highlight it. Click the Format button on the side of the notice window and choose Picture 
from the drop list. This opens the Format Picture window. You can also double-click the graphic to open this window.
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Layout tab – Choose the Wrapping Style for your graphic by clicking on the appropriate icon. If you 
choose to keep the graphic in line with the text of your notice, click a radio button to choose in line 
alignment of the graphic. 

The 4 fields under Space from text allow you to set a margin between your graphic and the surrounding text.

Size tab – Click the Size tab to adjust the sizing of the inserted graphic. You may either type a Height 
and Width (in inches) or type a percentage to reduce or enlarge the graphic.

Warning! Enlarging a graphic may result in poor quality, depending on the resolution (dpi) of 
the original graphic file. 300 dpi is the ideal resolution for printing graphics, though slightly lower 
resolution graphics may be acceptable. A resolution of 72 to 96 dpi provides acceptable quality 
for on-screen viewing (such as in an email ) ONLY.  Since you are viewing the graphic on screen in 
CDM+, we recommend you print a test copy of your letter or card to check it.

Clicking the checkbox next to Lock aspect ratio will prevent you from changing the proportions of the 
graphic when you re-size it. If you check this box, type a number in the Height or Width fields, and press 
tab, CDM+ will automatically enter the other proportionate dimension. This is a good way to make sure 
you don’t stretch photos and end up with distorted faces!

If the graphic is set to “In line with text” wrapping, you cannot drag it. Instead, cut and paste the graphic as if 
it were a piece of text. For all other wrapping options, you can drag the graphic using the (left) mouse button.

Data tab - In email notices, click the Data tab to add Alt Text to the images in the email notice. Alt 
text should describe the image or its purpose in a few words. The alt text is displayed when the 
recipient hovers over the image in the email.

Alt text with images is important for accessibility and understanding. Recipients who are visually 
impaired may use a text reader to read email content to them. The text reader will read the alt 
text so that the recipient knows about and understands the image. Also, if for some reason the 
image does not load for the recipient, the email client can display the alt text.
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Helpful hint: Providing alt text with your images not only helps visually impaired readers, but it 
also reduces the risk of the email notice going to their spam or junk folder.

Text Box
To insert a Text Box in your notice, place the cursor in the desired location, click the Insert button on the 
right of the notice editor window and select Text Box.

Layout tab – Functions the same as the Layout tab of the Format Picture window (see above).

Find and Replace Function

Size tab – Set the size of the text box in the top section of this window. You can also manually change 
the size of a text box in the notice editor window by placing your cursor on the edges or corners, holding 
down the (left) mouse button, and dragging.

The remaining 4 fields on this window set the amount the text is inset from the edges of a text box.

Border and Background tab – Use the radio buttons to select a Border Style and Line Style. If you wish 
to create a text box with no border, for instance to place a caption under a photo, leave the Border Style as 
None. With no Border Style chosen, the Line Style selected is immaterial.

Choose a color for the lines in the border by highlighting one of the color swatches in the Line Color list. 
The Line Size sets the width of the lines in the border.

Highlight a color swatch and name in the Fill Color list to set the color of the text box fill (background).
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Adding Hyperlinks

In email notices, you can set text in the email body to be a hyperlink to a web URL. In the Notice Editor, select 
the text that should serve as the hyperlink. Click the Insert button, and choose Hyperlink from the list. This 
will open the Insert Web Link window. You can modify the text in the notice by changing the Display Text 
value. Enter the target URL for the hyperlink, being sure to include the http:// or https:// prefix. Add Tooltip 
text. This text will display when the recipient hovers their cursor over the hyperlink text in the email. 

When done, click the Insert button.

Helpful hint: Providing tooltip text helps reduce the risk that your email notice will go to the recipient’s 
spam or junk folder.

Dictionary and Spell Check
CDM+ Notices include an automatic Spell Check feature that works while you type so you’ll never forget 
to use it. 

CDM+ Notices include a find and 
replace function. You can search (and 
optionally replace) the text in a Notice 
based on a particular word or phrase.

The spell check system includes a Custom Dictionary 
to which you can add words, which the spell check 
function “learns” so they won’t be marked in all notices.

Words that are not in the spell check dictionary are 
marked with a red squiggle underline. Right-clicking 
(or control-clicking on a Mac) on the suspect word 
brings up alternative suggestions, as well as options 
to Ignore this instance of the word, Ignore All 
instances of the word, or Add the word to the Custom 
Dictionary. 
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